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Chapter 3: Productivity Software: Navigation 

 

Key Concepts Covered in This Chapter: 

• The Power of Software 

• Starting and Operating the Computer 

• Starting Windows 7 

• Starting a program with the Start Menu 

• Working with Windows 7 

• Working with Files and Folders 

• Using Application Software 

 

The Power of Software 

What is Software? 

All computers have two main parts: the hardware and the software. The hardware 

represents the physical components of the computer such as: the monitor, central 

processing unit (CPU) and keyboard. By contrast, the software represents the intangible 

workings of a computer. In short, computer software is a collection of programs and data 

that tells the computer what to do and how to accomplish it. 
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Over the years, computer software has become more sophisticated and powerful to meet 

the needs of a diverse user audience operating in the information age. For software to be 

robust and useful, it must adhere to specific standards and be thoroughly tested before 

release to the end user. Software also needs to be compatible and function with other 

types of computer operating systems. Computer software can be classified into the 

following three main categories: 

• System software 

• Programming software 

• Application software 

 

Knowledge and use of different software programs is essential for effective computer 

use. Equally important is upgrading to the latest versions of software programs and 

learning the new features.  Fortunately, many software programs retain the basic 

functionally from version to version thereby eliminating steep learning curves once the 

user upgrades. 

 

The Operating System 

The operating system is the most important software component of a computer. Without 

an operating system, the computer cannot function properly. In short, the operating 

system is the software responsible for managing and controlling the hardware and 

software components and enables both components to communicate with each other. 

Computers today have two main operating systems to choose from: Windows and Mac 

OS. Learning the basic functionality and features of the operating system can increase a 

user’s productivity and comfort level while using a computer. 
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Starting and Operating the Computer 

Turning On the Computer 

Turning on a computer is accomplished by pressing the power button located on the front 

panel of the CPU (for desktop computers) or above the keyboard (for laptop computers). 

The power switch is identified by the universal power switch symbol (See Figure 1). 

 
Figure 1: Power Button 

 

Shutting Down the Computer 

To properly shut down a Windows 7 based computer, use the following steps: 

1. Click on the Windows Start icon located in the bottom left corner of the 

Windows screen. 

 

 

2. Click on the Shut down button at the bottom of the Start menu. 
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[Boxed item] FAQ: Should I turn my computer off at night? 

Computers have moving parts called hard disk drives that operate at high rates of speed 

for hours at a time. In order to prevent wear and tear on computer hard disk drives, it is 

probably best if computers are powered down at the end of the day or when not used for 

long periods of time. Powering down computers also conserves electricity. 

 

Using the Mouse 

The computer mouse is pointing device that allows a user to easily access and manipulate 

menus, programs, icons, and other types of graphical user interfaces (GUIs) displayed on 

a computer screen (See Figure 2). 

 
Figure 2: Mouse 

 

The mouse is best operated by resting the hand over the top of the device with the index 

finger covering the left mouse button and the  middle or ring finger covering the right 

mouse button (for right handed users).  

 

The mouse buttons can be clicked in a number of ways to achieve different outcomes. 

The following table describes some basic mouse clicking functions: 

 

 



IntroComputers_Chapter3_Draft1 
 

5 

 

Table 1: Mouse Clicking Functions 

Type of Click Mouse Button Purpose 

Single Click Left Mouse Button To select an image or icon 

To move items around the computer’s desktop 

To navigate the cursor through a word processing program 

Double-Click Left Mouse Button To execute an action such as opening a program 

Right-Click Right Mouse Button To expose shortcuts in a variety of programs 

 

Keyboard Alternatives to Using the Mouse 

Instead of using the mouse device, there are a variety of keyboard shortcut alternatives. 

The following table describes some common keyboard shortcuts for Windows based 

computers: 

Table 2: Keyboard Shortcuts 

Press This Key(s) To Accomplish This Result 

Ctrl+C Copy the selected item. 

Ctrl+X Cut the selected item. 

Ctrl+V Paste the selected item. 

Ctrl+Z Undo the last action. 

Ctrl+Y Redo the last action. 

Delete Deletes the selected item and moves it to recycle bin. 

Shift+Delete Delete the selected item without moving to recycle bin. 

Ctrl+Right Arrow Move the cursor to the beginning of the next word. 

Ctrl+Left Arrow Move the cursor to the beginning of the previous word. 

Ctrl+Down Arrow Move the cursor to the beginning of the next paragraph. 

Ctrl+Up Arrow Move the cursor to the beginning of the previous paragraph. 

Ctrl+Shift with arrow key Select a block of text. 

Shift with any arrow key Select more than one item in a window or on the desktop or select text within 

a document. 

Ctrl with any arrow 

key+spacebar 

Select multiple individual items in a window or on the desktop. 

Ctrl+A Select all items in a document or window. 

Alt+Enter Display properties for the selected item. 

Alt+spacebar Open the shortcut menu for the active window. 
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Alt+Tab Switch between open items. 

Ctrl+Alt+Tab Use the arrow keys to switch between open items. 

Ctrl+Mouse scroll wheel Change the size of icons on the desktop. 

Alt+Esc Cycle through items in the order in which they were opened. 

Ctrl+Esc Open the Start menu. 

Alt+Up Arrow View the folder one level up in Windows Explorer. 

Esc Cancel the current task. 

Ctrl+Shift+Esc Open the Task Manager. 

Ctrl+Shift Switch the keyboard layout when multiple keyboard layouts are enabled. 

 

 

The Function Keys 

The function keys are a row of keys labeled F1 through F12 located above the main 

keyboard. These keys can also be used as shortcut alternatives to using the mouse device. 

The following table describes each function key: 

 

Table 3: Function Keys 

Press This Function Key To Accomplish This Result 

F1 Opens the Help screen. 

F2 Renames a highlighted icon or file. 

F3 Opens a search feature for programs. 

F4 Opens a find window. 

F5 Refreshes or reloads a page or document window. 

F6 Moves the cursor to the Address bar in Microsoft Internet Explorer 

and Mozilla Firefox. 

F7 Launches spell and grammar check in Microsoft Office programs. 

F8 Enters Windows startup menu. Commonly used to access Windows 

Safe Mode. 

F9 Opens the Measurements toolbar in Quark 5.0 

F10 Activates the menu bar of an open application in Microsoft Windows. 

F11 Activates full-screen mode in all browsers. 

F12 Opens the Save As window in Microsoft Word program. 



IntroComputers_Chapter3_Draft1 
 

7 

 

Starting Windows 7 

The Windows 7 Welcome Screen 

After pressing the power button on the computer, the computer begins its power up 

sequence. During this time, the screen will display a startup screen followed by a Starting 

Windows screen with animated Windows logo. After these screens disappear, the 

Windows 7 welcome screen appears (See Figure 3). 

 
Figure 3: Windows 7 Welcome Screen 

 

The Windows 7 welcome screen may or may not have a login window. If the welcome 

screen does not have a login window, simply click on the image in the center of the 

screen. If the welcome screen has a login window, enter your Windows password and 

click the arrow at the right or press enter. 

 

Shut Down, Sleep and Restart Options 

Windows 7 offers the user several options for managing the computer while not in use. 

All of these options are accessed from the Windows 7 Start icon located in the lower left 

corner of the Windows screen (See Figure 4). 

 
Figure 4: Windows 7 Start Icon 
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After clicking on the Windows 7 Start Icon, each option can be selected by clicking on 

the arrow next to the Shut down button (See Figure 5). 

 
Figure 5: Shut Down Options 

 

The following is a brief description of three common shut down options: 

 

Restart: The restart option is used to briefly shut down the computer and immediately 

start it back up. This is commonly referred to as a “reboot” and is typically done to 

refresh the system after installing a new program or after a system update has occurred. 

Sleep: The sleep option places the computer in a paused power saving state without 

shutting the computer completely off.  In sleep mode, the computer can resume full-

power operation (usually in a matter of seconds) once the user presses a key or moves the 

mouse. 

Shut Down: The shut down option completely powers down the computer and is 

recommended as the proper way of powering down a Windows 7 computer. This method 

should always be used instead of pressing the power button. 
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[Boxed item] Interaction Diversity: The Ease of Access button in Windows 7. 

The Ease of Access button is located in the lower left corner of the Windows 7 welcome 

screen (See Figure 6). The Ease of Access menu contains six options that are designed to 

accommodate users with a disability. 

 
Figure 6: Ease of Access Button 

 

Other Logon Options for Windows 7 

If you do not have a user account setup on a Windows 7 computer, you have a couple of 

options for logging in at the welcome screen. The following describes two options 

available: 

 

Administrator: If the computer is new, a user can log on as Administrator. The 

Administrator can setup user accounts, install programs and access all files for all users. 

Guest: If the computer belongs to someone else, you can log in as a guest. The guest 

option allows a user to temporarily access files and programs. 

 

Overview of the Windows 7 Desktop 

The Windows 7 desktop has five main parts (See Figure 7). Each of these parts is briefly 

described below: 

 

Start Icon: The Start Icon is located in the lower left corner of the screen and accesses 

the main control panel for the Windows 7 system. The Start Icon can be used to start 

programs, adjust computer settings or shut down the computer. 
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Task Bar: The Task Bar is located at the bottom of the screen and contains all running 

programs, frequently used programs, computer system diagnostics and the date and time. 

Recycle Bin: The Recycle Bin is a waste basket shaped icon located in the upper left 

corner of the screen. The Recycle Bin contains discarded files that can be retrieved if 

accidentally deleted. The Recycle Bin can be permanently emptied if contents are no 

longer needed. 

Gadgets: Gadgets are small programs that have a specific purpose such as a clock, 

calendar or weather icon. These are usually located in the upper right corner of the 

screen. 

Icons: Icons are graphical representations of programs that are accessed in a shortcut 

manner instead of using the Start Menu. 

 

 
Figure 7: The Windows 7 Desktop 
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[Boxed item] FAQ: Why does my screen look different? Customization and installed 

programs. 

There are many ways to customize the Windows 7 desktop to personalize it. The theme 

or background can be changed to a photograph of a favorite vacation spot or an image of 

your family. Icons and gadgets can be moved into different locations on the screen. When 

new programs are installed on your computer, they can be set as shortcuts that will appear 

as icons on the desktop. 

 

Starting a Program with the Start Menu 

The Start Menu is launched from the Start Icon (See Figure 4 on page 7) located in the 

lower left corner of the Windows 7 screen. The Start Menu (See Figure 8) contains 

access to all programs, applications, computer settings and computer diagnostics. 

Programs can be easily launched from the Start Menu by either clicking on the program 

in the shortcut list in the left column or by clicking All Programs at the bottom left and 

searching for the program to launch. Access to files, computer settings or computer 

diagnostics can be accomplished by clicking on one of the categories in the right column. 

 
Figure 8: Start Menu Sections 
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Menus, Commands and Dialog Boxes 

Programs and applications on a computer are directed by the user through the use of 

menus, commands and dialog boxes. Each of these is briefly described below: 

 

Menus: A menu is a graphical collection of options and commands a user chooses from 

to direct a program or application to perform a specific function. 

Commands: A command is an instruction or directive that tells a program or application 

what to do. Commands are the “language” computers understand and respond to. 

Dialog Boxes: A dialog box is a small window that appears during the use of a program 

or application to ask the user a brief question or confirm an instruction or command. The 

intension of the dialog box is to establish a “dialog” between the user and computer. 

 

Using Windows 7 Help 

Access to Windows 7 help topics can be accomplished by clicking on the Help and 

Support button located at the bottom right column of the Start Menu (See Figure 9). 

Additional information and support can be found on the Microsoft web site at: 

http://support.microsoft.com/. 

 
Figure 9: Accessing Windows 7 Help 
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Working with Windows 7 

Opening and Closing Windows 

Opening a window for a program and application can be accomplished by simply 

clicking or double-clicking on an icon. This can also be accomplished by launching 

programs and applications from the Start Menu. 

 

Closing a window completely exits an application or program. This can be accomplished 

by clicking on the red X button located in the upper right corner of the window (See 

Figure 10). 

 
Figure 10: Closing a Window 

 

Maximizing, Minimizing and Restoring Windows 

Maximizing a window automatically increases the size of a window on all four sides and 

allows the window to occupy the entire screen. This can be accomplished by clicking on 

the rectangle button located in the upper right corner of the window (See Figure 11). 

 
Figure 11: Maximizing a Window 

 

Minimizing a window collapses a window back into an icon symbol and moves the icon 

away from the center of the desktop area. This can be accomplished by clicking on the 

dash button located in the upper right corner of the window (See Figure 12). 

 
Figure 12: Minimizing a Window 
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Restoring a window from a maximized state resizes a window back into the shape it was 

prior to maximizing it. This can be accomplished by clicking on the double square button 

located in the upper right of the window (See Figure 13). 

 
Figure 13: Restoring a Window 

 

Moving and Resizing Windows 

Moving a window can be accomplished by placing the cursor inside the top margin of the 

window and dragging the window while holding down the left mouse button. 

 

Resizing a window can be accomplished by positioning the cursor at any edge of the 

window until the cursor changes to a double arrow symbol then dragging the edge while 

holding down the left mouse button. 

 

Switching Between Windows 

Switching between windows is accomplished by clicking once on a window to make it 

active. The active window moves to the top of the window stack. 

 

Using Scroll Bars 

Scroll bars are sliding control tools that are located on the bottom and right side of 

windows. Scroll bars are used to slide the contents of windows up and down and left to 

right. The scroll bar is controlled by placing the cursor on the slider and moving it while 

holding down the left mouse button (See Figure 14). 
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Figure 14: Scroll Bars 

 

Status Bars 

The Status Bar is located at the bottom margin of a window and contains document 

information, tools, and shortcuts (See Figure 15). The Status Bar can be customized by 

placing the cursor inside the bar and clicking on the right mouse button. 

 
Figure 15: Status Bar 
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Using Windows Explorer 

Windows Explorer is the main file manager system for Windows 7 systems. Windows 

Explorer allows the user to quickly locate document files, photo files, music files, video 

files and other Windows programs and applications anywhere on the system. The 

Windows Explorer icon for Windows 7 is located in the bottom left corner of the screen 

(See Figure 16). 

 
Figure 16: Windows Explorer Icon 

 

The Windows Explorer Window 

The Windows Explorer main window displays the various categories where files, 

programs, and applications are stored. Clicking on any category will display the contents 

of that space (See Figure 17). 

 
Figure 17: Window Explorer Window 
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Renaming Files 

To rename a file, find and select the file from the Windows Explorer list and select 

Rename from the Organize pull down menu located at the top left corner of the 

Windows Explorer window (See Figure 18). As you type in the new name of the file, the 

characters will appear inside the highlighted box around the file name. 

 
Figure 18: Renaming a File 

 

Moving Files 

To move a file, find and select the file from the Windows Explorer list and drag it while 

holding down the left mouse button. Position the file over a destination folder or space 

and release the left mouse button. The file will be moved to the new destination. 

 

Copying Files 

To copy a file, find and select the file from the Windows Explorer list and select Copy 

from the Organize pull down menu located at the top left corner of the Windows 

Explorer window (See Figure 19). Move to the destination folder or space then select 

Paste from the Organize menu. The file will be copied to the new destination. 
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Figure 19: Copying a File 

 

Deleting Files 

To delete a file, find and select the file from the Windows Explorer list and select Delete 

from the Organize pull down menu located at the top left corner of the Windows 

Explorer window (See Figure 20). The file will move from the folder or space to the 

Recycle Bin. 

 
Figure 20: Deleting a File 
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[Boxed item] Interaction Diversity: Changing the screen resolution. 

To adjust the screen resolution, use the following steps: 

1. Position the cursor anywhere within the desktop then click the right mouse button. 

2. Select Screen resolution. 

3. Click the Resolution button and adjust the slider up and down to a desired 

resolution. 

 

 

4. Click outside the slider then click the Apply button. 

5. A dialog box appears to query the user to either Keep changes or Revert. 

Keeping the changes locks in the new resolution. Revert defaults back to old 

resolution settings. (Note: a decision must be reached within 15 seconds or new 

setting is discarded). 

6. If Keep changes option is selected, click the OK button to apply the new setting. 
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Working With Files and Folders 

Organizing Files within Folders 

Imagine working in an office environment without an organized filing system. Papers and 

file folders are spread out over desks and tables. Frantic employees spend hours looking 

for important documents that cannot be found in a timely manner. 

 

Computer systems are no different and require organization as well. A user could have 

files and folders spread out over many locations. Much like the office scenario, the user 

could also spend hours searching for forgotten or missing file or folder names. Taking the 

time to organize files and folders early on when using computers can pay huge dividends 

down the road. 

 

The following diagram illustrates a simple and organized folder structure: 

 

Figure 21: Folder Structure 
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Creating a Folder 

Creating a folder can be accomplished by double-clicking into one of the libraries located 

in the Window Explorer main window and then clicking the New folder button at the top 

(See Figure 22). 

 
Figure 22: New Folder Creation 

 

After clicking the New folder button, a new folder icon appears in the file listing with 

highlighted text that reads “New folder”. To rename the folder simply type in the new 

folder name then click outside the folder. 

 

When naming folders, consider a name that best represents what the folder will contain. 

For example, if the folder contains tax information for the year 2009, consider naming it 

“Taxes 2009”. Avoid long names and special characters such as: [ ] / \ ? & *. 

 

The Folder Window 

The Folder Window has four main parts (See Figure 23). Each of these parts is briefly 

explained below: 
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Navigation Pane: The navigation pane is the top hierarchy listing where all files, 

programs and applications reside on the computer.  

Address Bar: The address bar displays the horizontal path to where files, programs and 

application are located. 

Refresh Button: The refresh button updates the listing of content. 

Search Window: The search window searches the current location and lists all findings 

based on a specific keyword.  

 
Figure 23: Folder Window Parts 

 

Viewing and Manipulating Folders 

Folders can be resized and listed in eight different ways. To resize or change the listing of 

the folder and file  list, click the change view button on the top right side of the folder 

window (See Figure 24) then adjust the slider tool to the desired viewing preference (See 

Figure 25). 
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Figure 24: Change View Button 

 

 

Figure 25: Change View Slider Tool 

 

Folders can be expanded and collapsed by simply clicking on the diagonal arrowhead 

(See Figure 26). This allows the user to quickly view the contents of the main folder. 
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Figure 26: Folder Listings 

 

Saving a File to a Regular Folder 

To save a new file (such as a Word or Excel document) to a regular folder, use the 

following steps: 

1. Click the Save button under the File tab. 
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2. In the File name section, type in a new file name. 

 

 

3. Locate a folder destination by clicking on categories in the navigation pane or 

clicking on the individual folders listed in the main window. 

 

 

4. Once a destination folder has been selected, click the Save button. 
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When naming files, it is best to also follow the same guidelines as naming folders (See 

page 21). Remember to pick a name that best represents the contents of the file, keep the 

name brief and avoid special characters. 

 

Saving a File to a Shared Folder 

Windows systems have a feature that allows a user to save a file to a shared folder.  This 

feature is enabled through a software application called a Network Drive. The advantage 

of the Network Drive is that other computer users can access a shared folder’s files over a 

network connection. 

 

Saving a file to a shared folder requires two separate procedures: map a network drive 

and save a file to a shared folder. 

 

To map a network drive, use the following steps: 

1. From the Start menu, select Computer. 

2. Click on the Map network drive button at the top of the window. 
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3. In the Map Network Drive window, click the Drive button to select a drive letter 

then click the Browse button to select a shared folder. When complete, click the 

Finish button. 

 

 

4. The Network Drive icon will appear under the Computer icon in the navigation 

pane. 

 

 

To save a file to a shared folder, use the following steps: 

1. Click the Save button under the File tab. 
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2. In the File name section, type in a new file name. 

 

 

3. Click on the network drive icon located under Computer in the navigation pane. 

 

 

4. Click the Save button. 
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[Boxed item] FAQ: Why can’t I open this file? 

Different applications (such as Microsoft Word, Excel, and PowerPoint) produce files 

with different formats. These formats are usually identified by an extension at the end of 

the file.  

 

For example, if you tried to open a Word file without Microsoft Word installed on your 

computer, the file would not open.  The same holds true for any other Microsoft Office 

file. Each file’s extension can be identified by clicking on the file with the right mouse 

button and selecting Properties. Under the General tab, the type of file and its extension 

is defined. 

 

The following table lists some common extensions for Microsoft Office 2010 files: 

Table 4: File Extensions 

Microsoft Office Product Icon Image File Extension 

Word 
 

.docx 

Excel 
 

.xlsx 

PowerPoint 
 

.pptx 

 

 

Save and Save As 

There are two distinct ways to save a file. The differences between the two are described 

below: 
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Save: The Save command simply saves a new file to a folder or updates the data within 

an existing file. 

Save As: The Save As command allows you to save the contents of an existing file under 

a different name. 

 

Version Control of Files 

Windows makes it possible to track and restore previous versions of files that are 

generated by an automatic backup program. To view previous versions of a file, simply 

click on the file with the right mouse button then click Properties. Click the Previous 

Versions tab on the Properties pop up window to view the previous versions of the file. 

 

To restore a previous version, simply click the file with the right mouse button and select 

Restore previous versions. Select the version to restore then click OK to preview the 

restored file. 

 

Compressing and Zipping Files 

Many e-mail programs have difficulties managing large file attachments. A large file is 

typically defined as a larger than 5 Megabytes (or 5 MB). Windows offers a workaround 

solution to this problem by allowing the user to compress large files into a manageable 

size that can be successfully sent as an e-mail attachment. This procedure is called 

compressing or zipping a file. 
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To compress a file, simply click on the file with the right mouse button. Place your cursor 

over Send to then click Compressed (zipped) folder. Another folder icon appears with 

the same name as the file (See Figure 27). 

 
Figure 27: Zipped Folder Icon 

 

The zipped folder can then be uploaded and sent as an e-mail attachment. 

 

Using Application Software 

In addition to producing the Windows operating system, Microsoft Corporation produces 

an office productivity suite called Microsoft Office 2010. Microsoft Office 2010 

(depending on edition purchased) contains applications to produce a wide variety of 

documentation including: word processing files, spreadsheet files and presentation files. 

The following table lists the different Microsoft Office 2010 suite editions with 

applications included: 

Table 5: Microsoft Office 2010 Products 

Microsoft Office Edition Applications Included 

Microsoft Office 2010 Professional Word 

Excel 

PowerPoint 

OneNote 

Outlook 

Publisher 

Access 

Microsoft Office 2010 Home and Student Word 

Excel 

PowerPoint 

OneNote 
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Managing Office Files 

Microsoft Office 2010 applications offer many features for producing and printing 

documentation. The sections that follow will briefly describe some of these features. 

 

Creating a New Office File 

After the Office 2010 application has started, click on the File tab at the top left corner of 

the window (See Figure 28) then click New. 

 

Figure 28: File Tab for Word 

 

Depending on the application, Microsoft Office 2010 offers several template options to 

choose from. The following images (See Figures 29-31) display template options for: 

Word, Excel and PowerPoint: 

 

Template options for Microsoft Word 2010: 

 
Figure 29: Word Templates 
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Template options for Microsoft Excel 2010: 

 
Figure 30: Excel Templates 

 

Template options for Microsoft PowerPoint 2010: 

 
Figure 31: PowerPoint Templates 

 

Using a template provides an excellent starting point for creating a new file by giving the 

user a convenient predesigned framework for composing effective documents. Template 

offerings can range from fax cover sheets to expense reports. 

 

Using Backstage View to Create and Open a File 

One of the many enhancements included with Microsoft Office 2010 is a feature called 

Backstage View (See Figure 32). Simply by clicking on the File tab at the upper left 

corner of the window will display this view. Backstage View allows the user to manage 
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files, set options, adjust data within files and print and e-mail documents all within one 

space. 

 
Figure 32: Microsoft Word Backstage View 

 

To create a new Microsoft Word file using Backstage View, use the following steps: 

1. Click the File tab at the upper left corner of the window. 

 

 

2. Click the New tab in the far left column. 
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3. Double-click on a desired template. 

 

 

To open an existing Microsoft Word file using Backstage View, use the following steps: 

1. Click the File tab at the upper left corner of the window. 

 

 

2. Click the Recent tab in the far left column. 
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3. Locate the file under the Recent Documents listing then double-click the file. 

 

 

[Boxed item] FAQ: When should I use Access instead of Excel? 

In general, Access has the following three advantages over Excel: 

• When dealing with complex data and will need to generate reports from the data. 

• When you will need to create custom reports quickly. 

• When you need to store data for long periods of time. 

 

Opening a File Using Windows Explorer 

To open an existing file using Windows Explorer, use the following steps: 

1. Click on the Windows Explorer icon located in the bottom left corner of the 

screen. 

 

2. Search for a file by double-clicking into the Documents library. 
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3. Open a file by double-clicking the filename. 

 

 

[Boxed item] FAQ: What does a Browse button do? 

The Browse button is a navigation feature allowing a user to search for a file then select 

and place that file into a search field. Clicking a Browse button typically launches a 

dialog box with a path to files a user will select from. 
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Printing an Office File 

To print an existing Microsoft Word file, use the following steps: 

1. Click the File tab at the upper left corner of the window. 

 

 

2. Click the Print tab in the far left column. 

 

 

3. Select a Printer device then select printer Settings. When finished, click the 

Print button. 
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The following is a brief description of the printer settings: 

 

Print All Pages: This setting instructs the printer on how many pages to print. The user 

could instruct the printer to print all pages, one page only or a range of pages. 

Print One Sided: This setting instructs the printer to print pages on one or both sides. 

Collated: This setting instructs the printer on how to collate the pages of the document. 

Portrait Orientation: This setting instructs the printer to print pages in a vertical 

(portrait) or Horizontal (landscape) orientation. 

Letter: This setting instructs the printer what size paper is being used. 

Normal Margins: This setting instructs the printer on how to print document margins. 

1 Page Per Sheet: This setting instructs the printer on how many pages to print on one 

single sheet of paper. 

 

Closing an Office File 

To close a Microsoft Word file using the Backstage View, simply click on the File tab at 

the upper left corner then click Close on the upper left column. 

 

To close Microsoft Word, simply click the red X located at the upper right corner of the 

window (See Figure 33).  

 
Figure 33: Closing a Program 

 

If an open file has unsaved changes prior to closing the program, a dialog box will appear 

to query the user about saving the changes (See Figure 34). 
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Figure 34: Save Changes Dialog Box 

 

The Application Interface 

The main toolbar interface for Microsoft Office 2010 applications is called the Ribbon 

(See Figure 35). The Ribbon is located across the top of the window above the workspace 

and contains tabs, buttons and pull down menu shortcuts. 

 

 
Figure 35: Ribbon Interface for Word 

 

Clicking the individual tabs above the Ribbon will display a different interface. Each tab 

is categorized by function such as: inserting, viewing, page layout and reviewing. The 

Ribbon can be minimized (retracted) by clicking on the up arrow button located in the 

upper right corner of the window (See Figure 36). The Ribbon can be restored by 

clicking on the down arrow (See Figure 37). 

 

                                                       

                       Figure 36: Minimize Ribbon                      Figure 37: Maximize Ribbon 

 

Tabs 



IntroComputers_Chapter3_Draft1 
 

41 

 

For pull down menus, the Ribbon toolbar incorporates a feature called Galleries (See 

Figure 38). Galleries are small thumbnail images of what a setting will look like in a 

document. 

 

Figure 38: Cover Page Gallery 

 

The Ribbon interface also contains a small group of frequently used commands called the 

Quick Access Toolbar. The Quick Access Toolbar is located at the top left corner of the 

window (See Figure 39).  

 

 
Figure 39: Quick Access Toolbar 

 

The Quick Access Toolbar can be customized by clicking on the customization pull down 

menu. The customization menu allows the user to add or subtract command icons (See 

Figure 40). 

 

Customization 

Menu 
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Figure 40: Customization Menu 

 

Finally, the Ribbon interface has a feature called KeyTips that allows a user to use 

keyboard keys instead of a mouse to switch tabs or activate commands from the Quick 

Access Toolbar. To display the KeyTips, simply place the cursor inside the Ribbon and 

press the Alt key. Each tab or icon will be labeled with a bubbled letter or number. To 

execute a command, simply press the Alt key and the letter or number together to execute 

the specific command. The KeyTips feature also works hierarchically and will display 

more bubbled letters within each tab category. 

 

Using the Shortcut Menu 

Windows has a shortcut menu system called context-sensitive menus. Context-sensitive 

menus are activated by clicking the right mouse button anywhere on the screen. The 

menu choices will vary depending on where the right click occurs. Selecting any context-

sensitive command or option will execute the command directly. 
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Conventions for Entering and Editing Text 

Text entered into a document is always generated to the left of the flashing vertical line or 

insertion point. Much like our old friend the electric typewriter, mixed case typing is still 

accomplished through use of the Shift key, upper case typing is still accomplished 

through use of the Caps Lock key and using the Enter key begins a new line just like a 

carriage return. Beginning a new line can also be accomplished by continually typing to 

the right margin and allowing the computer to automatically begin a new line. 

 

Correction of typing errors can be accomplished in a number of ways. The Backspace 

key removes one character at a time while words and sentences can be removed by 

selecting the text and pressing the Delete key. Typing commands can be undone by 

pressing the Ctrl+Z keys or restored by pressing the Ctrl+Y keys. 

 

Conventions for Selecting Text 

Selecting text has many purposes from deleting to formatting. To quickly delete text 

without using the Backspace key, simply select the text and press the Delete key. To 

replace incorrect text, select the text to modify then type over the selected text.  

 

To cut and move text to another location, select the text then press the Ctrl+X keys to 

cut. Click the cursor at a new location then press the Ctrl+V keys to paste the text. To 

copy and move text to another location, select the text then press the Ctrl+C keys. Click 

the cursor at a new location then press the Ctrl+V keys to paste the text. 
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To format text, select the text to format then use the font formatting options in the Ribbon 

toolbar under the Home tab (See Figure 41). 

 
Figure 41: Font Formatting Options 

 

To move a block of text to a new location, select the block then drag the block while 

holding down the left mouse button. Release the left mouse button to place the block into 

its new location. To select an entire word, simply double-click on the word. To select 

large amounts of text in a single click, hold down the Shift key while clicking.  

 

[Boxed item] FAQ: How can I select items in a list? 

There are two ways to select items in a list: using the Ctrl key and using the Shift key. 

Each method is briefly described below: 

 

The Ctrl key: Holding down the Ctrl key allows the user to click and select specific 

items in a list. 

The Shift key: Holding down the Shift key allows the user to click the first item and the 

last item and select everything in between. 

 

Conventions for Working with Dialog Boxes 

As discussed previously in this chapter (See page 12), the dialog box is a small window 

that appears during use of an application or program that asks the user a brief question or 

confirms a command. The following are some basic conventions for working with dialog 

boxes in Windows 7: 
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Confirming or Canceling Queries: When a dialog box appears, the user is given an 

opportunity to confirm or “opt out” of a change. For example, if an unsaved document 

exists before exiting Microsoft Word, a dialog box will appear to ask the user to save, not 

save or cancel the changes (See Figure 42). 

 

 
Figure 42: Dialog Box Options 

 

Using Enter to Confirm a Selected Button 

In addition to the mouse, pressing the Enter key will also activate the highlighted button 

in a dialog box. 

 

Using the Tab Key to Select Buttons 

Using the Tab key will cycle through and highlight the different option buttons in a 

dialog box. 

 

Using the Esc Key to Cancel 

Using the Esc key will remove the dialog box completely from the screen. 

 

Commonly Used Office Commands 

Microsoft Office 2010 has hundreds of commands, options and features to choose from 

when creating documentation. The following briefly describe some common Microsoft 

Office commands: 
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Cut, Copy and Paste 

For text editing, cut, copy and paste are probably three of the most commonly used 

commands in Microsoft Office. The user has two choices when performing these 

commands: keyboard keys or menu options. For keyboard keys, the following keys are 

used: 

• For cutting, use the Ctrl+X keys 

• For copying, use the Ctrl+C keys 

• For pasting, use the Ctrl+V keys 

 

The cut, copy and paste menu options are located under the Home tab in the upper left 

corner of the window (See Figure 43). 

 

 
Figure 43: Cut Copy and Paste Menu Options 

 

Changing Views 

Microsoft Office 2010 offers many options for viewing documents. Clicking on the View 

tab in the interface Ribbon will display all viewing options (See Figure 44). 

 

 
Figure 44: View Ribbon 
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Using the Format Painter 

Using the Format Painter allows a user to apply formatting styles to other text with the 

click of a button. Simply click on the text with the desired style, click the Format Painter 

button then click on the text to re-stylize. The Format Painter button is located under the 

Home tab Ribbon in the upper left corner (See Figure 45). 

 

 
Figure 45: Format Painter 

 

 

Using Find and Replace Feature 

Using the Find and Replace feature allows the user to quickly search for keywords and 

replace them. The Find and Replace button is located under the Home tab Ribbon in the 

upper right corner of the window (See Figure 46). 

 

 
Figure 46: Find and Replace 
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Using Go To Feature 

Using the Go To feature allows the user to navigate to anywhere in the current document. 

The Go To menu is accessed through the Find pull down menu located under the Home 

tab Ribbon in the upper right corner of the window (See Figure 47). Simply click on the 

Find button pull down arrow then select Go To… 

 

 
Figure 47: Go To Feature 

 

Inserting Graphics and Symbols 

Microsoft Office 2010 offers the user hundreds of graphical options to enhance 

documents. Under the Insert tab Ribbon are several categories of graphics and symbols 

to choose from under the Illustrations grouping (See Figure 48). 

 

 
Figure 48: Graphics and Symbols 

 

 

Using the Thesaurus 

Microsoft Office 2010 contains a thesaurus that can be accessed under the Review tab 

Ribbon. Simply click on the Thesaurus button (See Figure 49) and enter the word into the 

interface on the far right column of the window. 

Graphics and 

Symbols 
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Figure 49: Thesaurus 

 

 

Spell Checking, Grammar Checking and AutoCorrect 

Microsoft Office 2010 has features to check spelling, grammar and to automatically 

correct both. The spelling and grammar checking feature is located under the Review tab 

Ribbon in the upper left corner of the window (See Figure 50). Each of the checking 

modes is briefly described below: 

 

Spell Checking: Microsoft Office 2010 checks the spelling of words against a preloaded 

dictionary within the application. Once a misspelled word is identified, the user is 

presented with several suggestions for correcting the word or allows the user to ignore the 

error. 

 

Grammar Checking: Microsoft Office 2010 also checks grammatical errors within 

sentences and offers the user suggestions for re-phrasing or allows the user to ignore the 

error. 

 

Auto Correcting: the AutoCorrect feature accepts the first highlighted item under the 

Suggestions window and applies that correction automatically to the word or phrase. 

 

 

 

Thesaurus 

Button 
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Using the Document Information Panel 

The Document Information Panel (See Figure 50) provides information and statistics on a 

given document and allows a user the ability to change properties of a document in one 

centralized location. The Document Information Panel is accessed by clicking on the File 

tab then clicking the Info tab in the far left margin. Settings and properties can be 

changed by clicking the three buttons on the left side of the window. 

 

 
Figure 50: Document Information Panel 

 

 

Using Office Help 

Accessing help information for any Microsoft Office application can be accomplished by 

simply clicking the question mark icon located in the upper right corner of the window 

(See Figure 51). 

 

 
Figure 51: Office Help Icon 

Adjust 

Setting and 

Properties 

Here 



IntroComputers_Chapter3_Draft1 
 

51 

 

Chapter Summary 

Few will argue that one of the most important skills in today’s market place is learning 

how to navigate and operate a personal computer. Over the years, computers have 

become smaller, more powerful, faster and capable of handling more information than 

ever before.  Knowing how to harness and use these advanced features can create 

limitless possibilities for the average computer user.  

 

Computers have also become more “user friendly” by engaging the user with simple 

menu systems and clearly labeled buttons. Tasks that used to take hours can now be 

accomplished in minutes using advanced software and programs. Imagine for a moment 

all of the organizing, writing, communicating, printing, entertainment and educating that 

can be accomplished from one machine. Let the journey begin. 


